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ABSTRACT: This document will guide authors to submit a full paper for the proceedings of the Sixth International Congress on Construction History (July 9-13 2018, Brussels). In order to ensure uniform style throughout
the proceedings, all the papers have to be prepared strictly according to the instructions set below. If you fail to
follow these instructions, the editors reserve the right not to publish your paper. A template for MsWord is
provided. The CPI_AR_PDF1.7.joboptions should be used to create the final Camera Ready Copy PDF file if
possible. Otherwise, save your MsWord file as PDF (using the Guidelines to create PDF files.pdf). The publisher will reduce the PDF to 75% and print it in black only. For this reason, please check if your figures will
be legible after reduction. To allow publication at the conference, all papers must be submitted online by December 1, 2017 (see http://6icch.org/paper-submission.html).

1 GENERAL INSTRUCTIONS
1.1 Type area

1.3 Typefont, typesize and spacing

The text should fit exactly into the type area of 187 
272 mm (7.36"  10.71"). For correct settings of margins in the Page Setup (File menu) see Table 1.

Use Times New Roman. Use roman type except for
the headings (Heading tags), parameters in mathematics (not for log, sin, cos, ln, max., d (in dx), etc), Latin
names of species and genera in botany and zoology.
Words or phrases in foreign languages used in English should be in italics. Titles of journals and books
should be in italics. Never use bold. Never underline
any text. Use single quotation marks to emphasize
words (but sparingly). Never use letterspacing and
never use more than one space after each other. Do
not include page numbers.

Table
1. Margin settings for A4 size paper.
_____________________________________________
Setting

A4 size paper
____________
cm
inches
_____________________________________________
Top
1.2
0.47"
Bottom
1.3
0.51"
Left
1.15
0.45"
Right
1.15
0.45"
All other
0.0
0.0"
Column width*
9.0
3.54"
Column
spacing*
0.7
0.28"
_____________________________________________
* Column dialog box in Format menu.

1.2 Length
The minimum length of full papers is six pages.
The maximum length of full papers is eight pages (including references, figures and tables). Figures and
tables are limited to 1/3 of the length of the full papers. References must be limited to 1 page.

1.4 Structure
The paper should contain the title, author(s) and affiliation, the abstract, an introduction, the body of the
paper, conclusions, acknowledgements (if any), and
references.
2 LANGUAGE
Authors are expected to ensure that the quality of the
English grammar and vocabulary are of a standard

suitable for publication. Ensure the English UK dictionary in MsWord is used to check spelling. For authors whose first language is not English, it is essential that the final version of their text is corrected by a
native English speaker who knows something about
the subject of the paper, before it is submitted. The
editors reserve the right not to publish any paper either through poor English or through poor content.

3.3 Abstract frame
Place the cursor one space behind the word ABSTRACT: and type your abstract of not more than
150 words. The top of the first line of the abstract will
be 73 mm (2.87") from the top of the type area. The
complete abstract will fall in the abstract frame, the
settings of which should also not be changed (Width:
Exactly 187 mm (7.36"); Height: Automatic; Vertical
73 mm (2.87") from margin; Lock anchor).

3 GETTING STARTED
3.1 Preparing the new file with the correct template
Before starting, make sure that you have a PostScript
printer installed. Select the correct files for your
printer: A4 paper size (21 x 29.7 cm, European size).
Copy the files which you will be using to a new directory and keep the original file as a backup.
Copy the template file Template.dot to the template directory. This directory can be found by selecting the Tools menu, Options and then by tabbing the
File Locations. When the MsWord programme has
been started, open the File menu and choose New.
Now select Template.dot. Start by renaming the document by clicking Save As in the menu Files. Name
your file as follows: First three letters of the file name
should be the first three letters of the last name of the
first author, the second three letters should be the first
letter of the first three words of the title of the paper
(e.g. this paper: balpat.doc). Now you can type your
paper, or copy the old version of your paper onto this
new formatted file.
3.2 Title, author and affiliation frame
Place the cursor on the T of Title at the top of your
newly named file and type the title of the paper in
lower case (no caps except for proper names). The title should not be longer than 75 characters. Delete the
word Title (do not delete the paragraph end). Place
the cursor on the A of A.B. Author(s) and type the
name of the first author (first the first name and then
the last name). If any of the co-authors have the same
affiliation as the first author, add his name after an &
(or a comma if more names follow). Do not include
any professional titles (e.g. Prof. or dr.). Delete the
words A.B. Author etc. and place the cursor on the A
of Affiliation. Type the correct affiliation (Name of
the institute, City, State/Province, Country). Now delete the word Affiliation. If there are authors linked to
other institutes, place the cursor at the end of the affiliation line just typed and give a return. Now type
the name(s) of the author(s) and after a return the affiliation. Repeat this procedure until all affiliations
have been typed.
All these texts fit in a frame which should not be
changed (Width: Exactly 187 mm (7.36"); Height:
Exactly 73 mm (2.87") from top margin; Lock anchor).

3.4 First line of text or heading
If your text starts with a heading, place the cursor on
the I of INTRODUCTION and type the correct text
for the heading. Now delete the word INTRODUCTION and start with the text after a return. This text
should have the tag First paragraph.
If your text starts without a heading you should
place the cursor on the I of INTRODUCTION, delete
the word INTRODUCTION, change the tag to First
paragraph, and type your text. Note that you should
always use the tag "First paragraph" after a heading.
For the rest of the text use "Normal text". When importing figures always use the Figures tag. Figures
cannot be imported on the paragraphs tag.
3.5 Copying old text onto new file
To insert text from another file, open that file as well,
select (Mouse) the text to be copied (Edit Menu), and
paste (Edit Menu) it onto bottom of new file, after
having deleted the word INTRODUCTION (see also
section 3.4). Check if the margin setting (Page Setup
dialog box in File menu) and column settings (see Table 1 for correct settings) are still correct. When the
new file contains all the text, the old tags in the text
should be replaced by the new Balkema tags. Before
doing this apply automatic formatting (AutoFormat in
Format menu).
4 LAYOUT OF TEXT
4.1 Text and indenting
Text is set in two columns of 9 cm (3.54") width each
with 7 mm (0.28") spacing between the columns. All
text should be typed in Times New Roman, 12 points
on 13 points line spacing except for the paper title (18
points on 20 points), author(s) (14 points on 16
points), the headings, and the small text in tables, captions and references (10 points on 11 points). All line
spacing is exact. Never add any space between lines
or paragraphs. When a column has blank lines at the
bottom of the page, add space above and below headings.
First lines of paragraphs are indented 5 mm (0.2")
except for paragraphs after a heading or a blank line
(First paragraph tag).

4.2 Headings

4.5 Tables

Only use the headings 1, 2 and 3 prepared by the publisher. Type primary headings in capital letters roman
(Heading 1 tag) and secondary and tertiary headings
in lower case italics (Headings 2 and 3 tags). Tertiary
headings are used as little as possible. Headings are
set flush against the left margin. The tag will give two
blank lines (26 points) above and one (13 points) beneath the primary headings, 1½ blank lines (20
points) above and a ½ blank line (6 points) beneath
the secondary headings and one blank line (13 points)
above the tertiary headings.
Headings are not indented and neither are the first
lines of text following the heading indented. If a primary heading is directly followed by a secondary
heading, only a ½ blank line should be set between
the two headings. In the MsWord programme this has
to be done manually as follows: Place the cursor on
the primary heading, select Paragraph in the Format
menu, and change the setting for spacing after, from
13 points to 0 points. In the same way the setting in
the secondary heading for spacing before should be
changed from 20 points to 7 points.

Locate tables close to the first reference to them in the
text and number them consecutively. Avoid abbreviations in column headings. Indicate units in the line
immediately below the heading. Explanations should
be given at the foot of the table: use *, **, etc. and put
the actual footnotes directly underneath the table. Use
only horizontal rules: One above and one below the
column headings and one at the foot of the table (Table rule tag: Use the Shift-minus key to actually type
the rule exactly where you want it). For simple tables
use the tab key and not the table option. Type all text
in tables in small type: 10 on 11 points (Table text
tag). Align all headings to the left of their column and
start these headings with an initial capital. Type the
caption above the table to the same width as the table
(Table caption tag). Captions should not exceed to 30
words. See for example Table 1.

4.3 Listing, numbering and quotations
When listing facts use either the style tag List signs or
the style tag List numbers.
Quotations are given within double quotation
marks (“...”). Quotations within quotations to be
given with single quotation marks (“...‘...’...”). Punctuation in a quotation should be exactly as the original. At the end of a quotation in a normal paragraph
the closing quotation mark should precede the fullstop. Omissions from a quotation to be indicated by
three stops ... without brackets. Words inserted into a
citation where text has been removed, in order to
maintain sense, should be included within square
brackets.
4.4 Equations
Use the equation editor of the selected word processing programme. Equations are not indented (Formula tag). Number equations consecutively and place
the number with the tab key at the end of the line, between parentheses. See for example Equation 1:
From the above we note that sin  = (x + y)z or:
Kt


 1 
 ca



  tan  
R2

4

k1

(1)

where ca = interface adhesion;  = friction angle at
interface; and k1 = shear stiffness number.
For simple equations in the text always use superscript and subscript (select Font in the Format menu).

4.6 Figure captions
Always use the Figure caption style tag (10 points on
11 points). Place the caption underneath the figure
(see Section 6). Type as follows: ‘Figure 1. Caption.’
Captions should not exceed to 30 words, including
subject, location, designer and date, as well as the
source & copyright details for images. Leave about
two lines of space between the figure caption and the
text. Figures must be referenced in the appropriate
place in the text, preferably after a full stop.
5 REFERENCES
The Chicago Style is used for references. For in-text
references, the author-date system is used. This
means that sources are briefly cited in the text, by putting the author’s last name, the year of publication in
parentheses. Each in-text citation refers to an entry in
the reference list at the end of the paper, which includes full bibliographical information.
For in-text references, page numbers can be added
after a comma if necessary (for an article or a chapter:
cite specific page numbers in the in-text references,
but include the page range for the whole article in the
reference list). If there are more than three authors,
only cite the first author and use “et al.”. If you don’t
have a date of publication, use (Author, in press),
(Author, in prep.) or (Author, unpubl.). If the author
has more than one publications in the same year, add
a, b, etc. If you mention the name of the author in the
sentence, you do not have to repeat it in the in-text
reference. For instance:
 (Author 1988, 12-14)
 (Author et al. 1989) instead of (Author, Author,
Author & Author 1989)
 (Author 1989a, b)
 Author and Author (1989)

At the end of the paper, list all references in alphabetical order underneath the heading REFERENCES
(Reference heading tag). The references should be
typed in small text (10 points on 11 points) and second and further lines should be indented 5.0 mm
(0.2") (Reference text tag).
If several works by the same author are cited, entries should be alphabetical and chronological:
Larch, A.A. 1996a. Development ...
Larch, A.A. 1996b. Facilities ...
Larch, A.A. 1997. Computer ...
Larch, A.A. & Jensen, M.C. 1996. Effects of ...
Larch, A.A. & Smith, B.P. 1993. Alpine ...

5.1 Typography for references
BOOK: Last name, First name and First Name Last Name. Year.
Book title. City: Publisher.
EDITED BOOK: Last name, First Name, ed. Year. Book Title.
City: Publisher.
CHAPTER of an edited book: Last Name, First Name. Year.
“Chapter Title”. In Book Title, edited by First Name, Last
Name, page-page. City: Publisher.
JOURNAL ARTICLE: Last name, First Name, First Name Last
Name and First Name Last Name. Year. “Title of article.”
Title of Journal (series number if necessary) volume number
(issue number if necessary): page numbers. (For articles consulted online, include a URL or the name of the database)
NEWSPAPER ARTICLE: Last name, First Name. Year. “Article title.” Newspaper, Month Day, Year. URL/name of database if applicable.
INTERVIEW: Last name of Interviewee, First Name. Year. “Interview Title”. Interview by First Name, Last Name. Publication Title, Month Day, Year.
DISSERTATION: Last name, First Name. Year. “Dissertation
title.” Academic Level, Name of University, College, or Institution.
WEBSITE: Last name, First Name OR Company Name. Year.
“Page title.” Accessed Month Day, Year. URL.
ARCHIVAL MATERIAL: Last name, First Name. Description
of the specific archival record. Date (day, month, year). Identifier (box/folder/item number). Name of collection, Name
of repository, Location of repository.
ARCHIVAL COLLECTION (when referencing multiple
items): Collection name, reference code. Repository, location.
PATENT: Last name, First Name OR Corporate Author. Title or
Description of Patent. Patent Number, date.

For other types of references, please use the Chicago
referencing style.
5.2 Examples
Grazer, Brian, and Charles Fishman. 2015. A Curious Mind: The
Secret to a Bigger Life. New York: Simon & Schuster.
D’Agata, John, ed. 2016. The Making of the American Essay.
Minneapolis: Graywolf Press.
Thoreau, Henry David. 2016. “Walking.” In The Making of the
American Essay, edited by John D’Agata, 167–95. Minneapolis: Graywolf Press.
Keng, Shao-Hsun, Chun-Hung Lin, and Peter F. Orazem. 2017.
“Expanding College Access in Taiwan, 1978–2014: Effects
on Graduate Quality and Income Inequality.” Journal of Human
Capital
11,
no.
1
(Spring):
1–34.
https://doi.org/10.1086/690235.

Mead, Rebecca. 2017. “The Prophet of Dystopia.” New Yorker,
April 17, 2017.
Stamper, Kory. 2017. “From ‘F-Bomb’ to ‘Photobomb,’ How
the Dictionary Keeps Up with English.” Interview by Terry
Gross. Fresh Air, NPR, April 19, 2017. Audio, 35:25.
http://www.npr.org/2017/04/19/524618639/from-f-bombto-photobomb-how-the-dictionary-keeps-up-with-english.
Google. 2017. “Privacy Policy.” Privacy & Terms. Last modified April 17, 2017. https://www.google.com/policies/privacy/.
Rutz, Cynthia Lillian. 2013. “King Lear and Its Folktale Analogues.” PhD diss., University of Chicago.
Wilson, Budge. Typescript of short story Brothers and Sisters by
Budge Wilson. 2000. MS-2-650.2013-070, Box 3, Folder 9.
Budge Wilson fonds. Dalhousie University Archives, Halifax, Nova Scotia, Canada.
Henry Davies Hicks fonds, MS-2-511. Dalhousie University Archives, Halifax, Nova Scotia, Canada.
Iizuka, Masanori, and Hideki Tanaka. Cement admixture. US
Patent 4,586,960, filed June 26, 1984, and issued May 6,
1986.

5.3 Notes
Notes should be avoided. Insert the information in the
text.
6 PHOTOGRAPHS AND FIGURES
Number figures consecutively in the order in which
reference is made to them in the text, making no distinction between diagrams and photographs. Figures
should fit within the column width of 90 mm (3.54")
or within the type area width of 187 mm (7.36").
Figures, photographs, etc. can be in black/white or
full colour, but will be produced in the book in
black/white only. For this reason, avoid the use of colour in figures and photographs. If you decide to use
colour pictures, make sure that they are readable
when printed in black.
Authors must obtain written permission to use any
images or quotations subject to copyright free of
charge in advance of submission.
Please insert the high-resolution figures (see Artwork.pdf) in the MsWord file. Figures, etc. should not
be centred, but placed against the left margin. Leave
about two lines of space between the text and figure
or caption. Never place any text next to a figure.
The most convenient place for placing figures is at
the top or bottom of the page. Avoid placing text between figures as readers might not notice the text.
Keep in mind that everything will be reduced to 75%.
Therefore, 9 points should be the minimum size of the
lettering. Lines should preferably be 0.2 mm (0.1")
thick. Keep figures as simple as possible. Avoid excessive notes and designations.
Photographs should be with good contrast and
preferably in TIFF or EPS format, CMYK encoded
and 600 dpi (see Artwork.pdf). Photographic reproductions cut from books, photocopies of photographs
and screened photographs are unacceptable.

8 SUBMITTING THE PAPER

Figure 1. Caption of a typical figure. Photographs will be
scanned by the printer. Always supply original photographs.

7 PREFERENCES, SYMBOLS AND UNITS
Consistency of style is very important. Note the spacing, punctuation and caps in all the examples below.
 References in the text: Figure 1, Figures 2-4, 6, 8a,
b (not abbreviated)
 References between parentheses: (Fig. 1), (Figs 24, 6, 8a, b) (abbreviated)
 USA / UK / The Netherlands instead of U.S.A. /
U.K. / Netherlands / the Netherlands







Always use the official SI notations:
kg / m / kJ / mm instead of kg. (Kg) / m. / kJ. (KJ)
/ mm.;
20°1632SW instead of 20° 16 32 SW
0.50 instead of 0,50 (used in French text); 9000 instead of 9,000 but if more than 10,000: 10,000 instead of 10000
14
C instead of C14 / C-14 and BP / BC / AD instead
of B.P. / B.C. / A.D.
× 20 instead of 20 / X20 / x 20; 4 + 5 > 7 instead
of 4+5>7 but –8 / +8 instead of – 8 / + 8
e.g. / i.e. instead of e.g., / i.e.,

Figures to be used for measurement (4.3 m) but
time to be in words (seven years, the eighteenth century). All other figures up to ten, in words (e.g. four
reasons) and over ten in figures (e.g. 17 lorry loads).
In the text, percentages are given in figures (e.g. 12.5
per cent). Use metric measurements where possible.
Provide conversions to metric when quoting original
sizes or where discussion requires use of original
units.
Time spans to include last two digits, except when
crossing a century (1935-42; 1890-1905). Decades to
be written as ‘the 1930s’. Months to be spelt in full in
the text and abbreviated in References.
Lower case is used for geographical divisions (the
north-east of England), but upper case for political
ones (South Africa).

Papers can only be submitted online. Authors have to
submit the original MsWord file *.doc as well as an
identical *.pdf file, using the option 'embedded fonts'
in pdf-file preparation (see Guidelines to create PDF
files.pdf). A camera-ready copy PDF file of the complete paper should be created with the
CPI_AR_PDF1.7.joboptions fileif possible. Check
whether the PDF is identical to the MsWord file and
whether the paper looks the same as this
document.
All figures should be embedded as high-resolution
files in the MsWord file and have to be submitted as
separate files as well (with a preferred format of .TIFF
or .EPS, see Artwork.pdf).
All files should be named with the same six-letter
combination (three letters of the last name of the first
author + first letter of first three words of the title, see
above: section 3.1). For figures and tables, please add
‘_fig#’ or ‘_tab#’ to the file name (replace # with the
appropriate number).
More details on how to submit the documents will
be available on http://6icch.org/paper-submission.html.
9 DEADLINE
All necessary documents should be submitted by December 1, 2017. Any material received too late will
not be published.
10 ASSISTANCE
For additional information on the submission procedure, please visit the website http://6icch.org or contact the 6ICCH Secretariat at info@6icch.org.
Please see to it that your paper has the same typography as the CRC Press / Balkema templates. For further information, please contact Mr. Lukas Goosen,
Production Manager at lukas.goosen@taylorandfrancis.com.

